USB to RS-232 Extender

User’'s Manual
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Introduction

The USB to RS-232 Cat. 5 extender is a low cost hardware solution that will extend your RS-232 devices using a
single standard Cat. 5/ 5e / 6 UTP cable. It provides full-duplex remote access and control of any RS-232 protocol
device. The USB to RS-232 Cat.5 extender kit consists of a local transmitter and remote receiver. It provides you with
a tremendous amount of flexibility in your installation. You can place RS-232 devices in any location you want and

control them remotely up to 90 meters ( 270 ft).

System Requirements

= Windows OS : 98SE / ME / 2000/ XP / Vista/ 7 /8 / 8.1 / 10; Windows server OS 2003 / 2008 / 2008R2 or

higher; WinCE OS: V4.2 ~ V7.0
L Mac OS: 8.6 / 9.x / 10.x or higher; Linux OS: Kernel 1.5.0 or higher
L The system is equipped with USB Host Controller

Features

Compatible with all RS-232 protocols.

Extend RS-232 peripherals up to 90 meters.

Fully Compliant with USB specification 1.1 and 2.0
Supports transfer rate up to 230kbps.

Supports +15kV HBM ESD protection.

Specification

Bus-powered - no external power supply required for local or remote unit.

Model No. UTS-101E DB-9M Pin Assignment
Chip FTDI Pin No. Definition
Transmitter Host 15 cm USB cable with USB Type A Male 1 DCD
Connec Output RJ-45 Female 2 RXD
tor Receiver Input RJ-45 Female 3 TXD
Device DB-9 Male 4 DTR
Interconnection Cable Standard Cat. 5/5e / 6 5 GND
LED Transmitter 1 ( Power) 6 DSR
Receiver 3 (TX/ Power/RX) 7 RTS
Power Mode Bus 8 CTS
Housing Plastic 9 R|
Dimension (L xW x H) 66 x 39 x 20 mm
Operation
1. Connect transmitter USB cable to the host computer.
2. Connect Cat.5 ( or better ) to transmitter RJ-45, and connect Cat.5e ( or better ) to remote RJ-45
3. Connect RS-232 device to accomplish.
4, LED indicates power supply is on.

NOTE: Ensure the driver is installed before operating products. FTDI Chip drivers can be downloaded and setup with
Windows OS 2000 or higher. To update drivers, please unload old version, then re-plug devices, the Windows
Update will detect and update automatically. (Above requires internet connected). Or refer to pages below to install

unit driver from CD.
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Windows OS Installation Guide

Driver can be installed through Windows Update automatically (Internet connection needed)
The FTDI drivers that have passed the WHQL tests are available for download using Windows Update.

OS requirements: Windows 7/8/8.1/10 or later.

Please go below ways for easy installation.

1. You may plug the device into host computer. And then it will pop up ‘Installing device driver software’ from the
taskbar of the screen. (Fig. 1) Click and connect to the Windows Update.

2. It will check your computer OS and download the applicable driver at the Windows Update automatically.

Installing device driver software % *

Click here for status,

Fig. 1

3. The program goes ‘Searching Windows Update’ from ‘Driver Software Installation’. (Fig. 2)

Installing device driver software

Generic USB Hubk
LISE «-= Serial i_)5earching Windows Update... I

Obtaining device driver software from Windows Update might take a while.
Skip obtaining driver software from Windows Update

Close

Fig. 2

4. When the applicable driver is detected, it will run ‘Installing device driver software’. (Fig. 3)

-
"_! Driver Software Installation

Installing device driver so

f'twaf
USE <-> Serial {_J Searching preconfigured driver folders... |

Fig. 3
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5. Then it shows ‘USB Serial Port (COMS) installed’. Click ‘Close’ and go next step. (Fig. 4)

-
"_! Driver Software Installation

Your device is ready to use
USE Serial Converter JReady to use
USE Serial Port (COME) JReadyto use

Fig. 4

6. Check ‘Device Manager’ of Control Panel from the computer OS and there shows USB Serial Port (COMS8) under
‘Ports (COM & LPT)’; the other one shows USB Serial Converter under ‘Universal Serial Bus controllers’. (Fig. 5)
Congratulation! You have finished installing the USB to Serial device successfully.

[ & Device Manager oo
Flle Action View Help
e D EH HE W B S

" & Network adapters =

b Kl Portable Devices
4.3 Ports (COM &L LPT)

' USE Serial Port (COMS)

'> D Processors
b -% Sound, video and game controllers
| b |l System devices

a- ﬂ Uniwversal Serial Bus controllers

..... § Generic USB Hub

| | i Generic USE Hub

----- i Generic USE Hub

..... ¥ USE Root Hub

..... ¥ USB Root Hub

..... § USB Root Hub

..... ¥ USE Root Hub i
..... ¥ USE Root Hub

..... ¥ USB Root Hub

..... USE Root Hub

m

oo UsSh hoo
e E USE Serial Converter
HE ")

[ T S 1 W S Ve YRR 1 1) P

Fig. 5

NOTE: It may occur when driver is not installed successfully, please check below steps.

1. There is busy on access databank of Microsoft's Support link. Please try again or install driver of CD-ROM
provided.

2. Check your internet if it is failed to access Microsoft's Support link.

3. Check your computer configuration if it is disabled on Windows Update wizard.

-
Device driver software was not successfully installed

Please consult with your device manufficturer for assistance getting this devicinstalled.
USB <-» Serial an driver found

What can I do if my device did not install properly?

Close
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Driver Installation thru the FTDI Driver Package
Driver can be installed through the FTDI driver package of the CD-ROM provided.

1. Double click ‘Setup_v2.12.00 WHQL Certified For Windows OS_x86.x64.exe’

El '- '- i_l .' r

Linux(1.5.00 Mac O5 8_9 Mac O5 X 10.9 Windows Windows
and above(2.3)  98ME(1.09.06) 2000(2.06.00)

m

B ‘

Windows CE Windows RT XP, 2003 Vista 0 | Setup_v2.12.00
42-52 6.0 Mo 08,7,8,8.1,20QBR | WHQL Certified
bile 2,2012R2(2.180 For Windows
2003,20035E,5... 0 OS_xB6.x04.exe

2. It will pop up ‘FTDI CDM Drivers’ from the screen. Click ‘Extract’ and go next step.

@ FTDI CDM Drivers [ |

FTDI CDM Drivers

Click 'Extract’ to unpack version 2,12.00 of FTDI's Windows
driver package and launch the installer.

wwnwy ftdichip .com

Cancel
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3. Extracting Files

' ™

Extracting Files
FreeExtractor is extracting the compressed files in this archive.,

Please wait while the files in this archive are extracted.

Extracting Static/i386/ftd2wclib ...

| | Cancel

4. Click ‘Next’ to continue.
- A
Device Driver Installation Wizard

Welcome to the Device Driver
Installation Wizard!

This wizard helps you install the software drivers that some
computers devices need in order to work.

To continue, click MNesdt.

< Back
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5. Select ‘I accept this agreement’ and click ‘Next’.

Device Dnver Installation Wiza

Ta cortinue, accept the following license agreement. To read the entire
agreement, use the scroll bar or press the Page Down key.

IMPORTANT NOTICE: PLEASE READ CAREFULLY BEFORE -
INSTALLING THE RELEVANT SOFTWARE: |:|
This licence agreement (Licence) is a legal agreement between you
{Licensee or you) and Future Technalogy Devices Intemational Limited

of 2 Seaward Place, Centurion Business Park, Glasgow G41 THH,
Scotland (UK Compary Mumber SC136640) (Licensor or we) for use of
driver software provided by the Licenson(Software).

BY INSTALLING OR USING THIS SOFTWARE YOU AGREE TO THE -

(@ accept this agreement; [ Save fis ] [ Erint
) | don't accept this agreement

6. The Device Driver Installation Wizard will detect your computer OS and install the applicable driver automatically.
Device Driver Installation Wizard '

The drivers are now installing___

. &

L -

Please wait while the drivers install. This may take some time to complete.
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7. While the Device Driver Installation Wizard is completing, click ‘Finish’ to exit.

Device Dniver Installation Wizard

Completing the Device Driver
Installation Wizard

The drivers were successfully installed on this computer.

You can now connect your device to this computer. F your device
came with instructions, please read them first.

Driver Name Status

w* FTDI CDM Driver Package - Bus/D2X... Readyto use
w* FTDI CDM Driver Package - VCP Driv... Readyto use

L i

Finish

Windows 98 Installation Guide

If a device of the same type has been installed on your machine before and the drivers that are about to be installed
are different from those installed already, the original drivers need to be uninstalled. Please refer to the uninstalling
instruction.

Download the latest available drivers from the FTDI website and unzip them to a location on your PC.
Connect the device to a spare USB port on your PC. This will launch the Windows Add New Hardware Wizard.

Windows may display a message reading "Building driver database" at this point which may take a few minutes to
pass. Click "Next" to proceed with the installation.
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Add Hew Hardware Wizard

Thiz wizard zearches fol new drivers for:

LI5E <-» Serial Cable

& device diver is a software program that makes a
hardware device wark,

< Haok

Caricel |

Select "Search for the best driver for your device. (Recommended) as shown below and then click "Next".
Add New Hardware Wizard

What do pou want Windows to do?

% Search for the best driver for wour device, |
[Recommended].

" Display a list of all the drivers in a spectic
location, 20 you can select the diver pou want,

< Back I Mest = I Cancel

Check the box next to "Specify a location" and uncheck all others as shown below. Click "Browse" and locate the
driver files. Once the files have been located, click "Next" to proceed with the installation.
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Add Hew Hardware Wizard

“wifindowes will zearch for new drivers in its diver database
on vour hard drive, andin any of the following zelected
lozations. Click Mest ta start the zearch.

[ Floppy disk dives
[T CO-ROM dive
[ Microsoft Windows Update

W Specify a location:
|c:t |
Erowse... |

< Back I Mest s I Cancel |

Windows may display a message reading "Building driver database" at this point which may take a few minutes to
pass. Once Windows has found the required files, click "Next" to install the device.

Add New Hardware Wizard

“Windows driver file search for the device:

IISB Senal Conwerter

“Winoows is now ready b install the best diver faor this
device. Click Back to select a different driver, or chok Mext
to continue.,

Location of driver:

CAVCPDRITINFTDIBUS.INE
= Rl

< Back

Cancel |

If the driver being installed does not have Microsoft WHQL signature files (.CAT files), the wizard will request a driver
disk to attempt to find them. Click "OK" on the "Insert Disk" message box.
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Inzert Disk E2 |

0 Flease ingert the dis< labeled 'FTDI USE Drivers Digk!, and then click OF.

The following window will appear to assist in locating the file. To proceed with the installation without the .CAT file,
click "Skip File".

Inzert Disk

The file 'frdibus.cat on FTD0 SE Drivers 0k
é‘ Liisk cannot be found.

Cancel

Inzertt FTODI USE Drivers Digk in the zelected
drive, and click OF.

Skip File

Dietails. ..

LCooy files from:

CACR Dirivers j Browse. ..

UES),

If the driver being installed is Microsoft WHQL certified, then the .CAT files will be located with the other driver files
and should be installed automatically.

Windows should then display a message indicating that the installation of the serial converter driver was successful.
The COM port emulation driver must now be installed. Click "Finish" to complete the installation of the serial

converter and proceed to the COM port emulation driver.
Add Mew Hardware Wizard

% USE Serial Converter

Windows has finished inztaling the softwane that your new
hardware device requires.

<Back |07 Finsh

Cancel I

Under Windows 98, the COM port emulation driver will be automatically installed from the same location as the serial
converter driver. However, if the driver is not WHQL certified as explained above for the serial converter driver, the
wizard will ask for the location of .CAT files. Click "OK" on the "Insert Disk" message box.
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Insert Digk ] |

Q Flease inzert the diz+ labeled FTOI USE Drivers Dizk', and then click OF.

The following window will appear to assist in locating the file. To proceed with the installation without the .CAT file,
click "Skip File".

Inzert Dizk E3 |

The file 'frdiport.cal on FTC USE Drivers k.
g_l Dizsk cannot be found,

Cancel
Inzert ETDI USE Drivers Digk in the zelected
drive, and click OF.

Skip File

Detailz...

- | Browsze...

Cooy files from;
CHEEP Dirivers

PR Lk

If the driver being installed is Microsoft WHQL certified, then the .CAT files will be located with the other driver files
and should be installed automatically.

Open the Device Manager (located in "Control Panel\System" then select the ""Device Manger" tab) and select "View
devices by type". The device appears as an additional COM port with the label "USB Serial Port".
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System Properties E |

General Device Manager |Hardware F'ru:ufilesl F‘erfu:urmanu:el

' View devices by lype i Wiew devices by connection

#-#% Keyboard -]
A-Z3 Madem

g Morikars

-y Mouse

\> FutlO Controller
-8 Metwork adapters
- Ports [COM & LPT)
”_l)y" Commurications Port [COM1]
. PCIECP/EPP Part [LPT1)
K_FB" PCI Serial Poit [COMZ)

- Iriverzal Senal Buz controllers
- Iriverzal Senal Buz controllers

Ll
o
ol
e
x
=
=
o
=k
o
]
L)

Properties | Refrezh | Remove | Frirt... |

Please note:

1. For multiple-port converter, each port has to be installed with the driver individually, i.e. you have to repeat this
installation procedure 2 times (2-port converter) or 4 times (for 4-port converter).

2. If you have any difficulties with the drivers we provided in this CD, you may download the updated or appropriate
versions from FTDI Web site: www.ftdichip.com/Drivers/VCP.htm, supported device “FT232BL(M)".
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Uninstalling Instruction
To uninstall drivers, follow the instructions below:
Disconnect any devices that are attached to the PC.

Open the Add/Remove Programs utility located in "Control Panel/Add/Remove Programs". Select "FTDI USB-Serial
Converter Drivers" from the list of installed programs.

Add/Remove Programs Properties EE

Install /U rinstal | Windows Sebup I Startup Digk I

T o nztall a new program from a floppy digk or CO-BOM
drive, click [nstall.

Iriztall...

Wirdows. Toremowe aprogram or b modiy its installed
components, zelect it from the list and click
Add/A emove.

IP% The following goftware can be automaticall removed by
e

Chineze [Traditional] Languane Supy
FTDILISE-to-Senal Coryerter Drivers
GetRight

[ngtantCD/DOND —J
Internet Explorer Q828750

Japanese Language Support
FemmelDiiver

F.ep Drive 1.0
¥.orean Language Support ll

Add/Bemove... I

0K Cancel | | 2l |

Click the "Add/Remove" button. This will run the FTDI uninstaller program. Click "Continue" to run the uninstaller or
"Cancel" to exit.

FTDI Uninstaller v3.0 ]|

If your USB device is connected, pleaze unplug it now. __

Prezz Continue to uninstall the drivers, or Cancel to quit.

Continue |
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When the uninstaller has finished removing the device from the system, the caption on the "Cancel" button will
change to "Finish". Click "Finish" to complete the process.

FTDI Uninstaller ¥3.0

[EEfItTiE
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Troubleshooting

1. Windows 98 cannot find drivers for my device

This error can occur if the VID and PID programmed into the device EEPROM do not match those listed in the INF
files for the driver. The VID and PID programmed into the device EEPROM may be found by using the USBView
utility from the FTDI website. These can then be checked against the VID and PID entries in the driver INF files. If
they do not match, that driver cannot be installed the VID and PID entries in the driver INF files. If they do not match,
that driver cannot be installed for that device without either re-programming the device EEPROM or modifying the list
of VID and PID numbers in the INF files. Please note that only your own company VID and PID or FTDI's VID
(0x0403) and FTDI PID issued for use by your company should be used in the EEPROM and INF/INI files.

2. Windows 98 forces a reboot after installing a device

This problem can occur if an application is accessing a file while the New Hardware Wizard is trying to copy it. This
usually occurs with the FTD2XX.DLL file. If installing a D2XX device, selecting not to restart the computer then
unplugging and re-plugging the device may allow the device to function properly without restarting. Restarting the
machine will allow the device to work correctly.

3. Driver installation fails and Windows 98 gives error code 10

Windows error code 10 indicates a hardware error or failed driver installation. This error may appear if a device has
insufficient power to operate correctly (e.g. plugged into a bus powered hub with other devices), or may indicate a
more serious hardware problem. Also, it may be indicative of USB root hub drivers being incorrectly installed. Please
refer to the example schematics on the FTDI website for standard device configurations. If the error persists, please
contact the FTDI support department.

4. Windows 98 complains about missing .CAT files

Files with the .cat extension are signature files issued by Microsoft that indicate a device driver is WHQL certified. If a
driver is not certified, there will be no .cat files available.

When installing drivers in Windows 98 or Windows ME, the user is prompted to locate the .cat files if the operating
system cannot find them. If the driver is not certified but you wish to install it anyway, the files may be skipped by
clicking the "Skip" button.

5. Windows 98 complains about missing ftccomms.vxd file
This can occur when the USB Composite driver has been installed if the user has not browsed to the location of the

driver files. If this message appears, do not skip it but browse to the driver file location. The wizard will then be able to
correctly install the device.
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Windows 2000 Installation Guide

If a device of the same type has been installed on your machine before and the drivers that are about to be installed

are different from those installed already, the original drivers need to be uninstalled. Please refer to the uninstalling
instruction.

Download the latest available drivers from the FTDI web site and unzip them to a location on your PC.

Connect the device to a spare USB port on your PC. Once the composite driver has been installed the Found New
Hardware Wizard will launch. Click "Next" to proceed with the installation.

Found Mew Hardware Yizard

Welcome to the Found New

ST -
Q Hardware Wizard

Thiz wizard helpz vou instal 2 device driver for 2
hardware device,

To continue, chck Mesxt,

% Back l M et = | Cancel
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Select "Search for a suitable driver for my device (recommended)" as shown below and then click "Next".
Found Mew Hardware Wizard
Install Hardware Device Drivers

&, device driver iz a software program that enables a hardware device to work, with
an operating system.

Thiz wizard will complete the inztallation far thiz device:

@ USE <-» Serial Cable

& device diver iz a software program that makes a hardware device work. Sindows
needs diver files for your new device. To lozate diver files and complete the
inztallation click Mest.

YWhat do pou want the wizard to do?
¥ Search for a suitable diver for my device [recommended)

£ Display a list of the known drivers for this device zo that | can choose a specific
driver

< Back I MHest = I Cancel

Check the box next to "Specify a location" and uncheck all others as shown below. Clicking "Next" displays a dialog
box for you to enter to the location of the drivers.

Found Mew Hardware VWizard

Locate Driver Files
Where do you want \Windows bo search for driver files?

Search far driver files for the following hardware device:

@ USE <-» Serial Cable

The wizard searches for suitable drivers in itz diiver databaze on your computer and in
any of the following optional zearch lozations that you specify.

T o start the zearch, click Mest. If you are searching on a floppy disk ar CO-BOM drive,
ingert the Hoppy digk or C0 before clicking Hest.

Optional gearch locations:
™ Floppy disk drives
[ CO-ROM dives
¥ Specify a location
[ Microzoft Windows Update

¢ Back I MHest = I Cancel
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Found Mew Hardware Wizard X
[nzert the manufacturer's installation disk inta the drive 0K |
g zelected, and then chck OF.

Cancel |

Ix

Copy manufacturer's files from;

|CACDM 2.00.00 | | Browss. |

Click "Browse" to display an open file dialog box.

2 x|
Lok ir: | <= COM 2.00.00 ~| & ®=cf E-

X,

File name: [FToIBUS INF -]
Files af type: ISetup Intarmation [*.inf] LI Carcel |

Locate the folder containing the latest drivers downloaded from the FTDI web site above and click "Open", then click
"OK". The PC auto selects the correct INF file, in this case FTDIBUS.INF.
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Once Windows found the required driver .INF file, click "Next" to proceed.

Found Mew Hardware Yizard i

Driver Files Search Results o
The wizard hasz finished szarching for driver files for your hardiware device.

The wizard found a driver for the following device:

@ USE <-» Serial Cable

Windawsz faund a driver for thiz device. Ta nztall the driver Windows found, chick Mest.

E cehedm 2 00004 kdibuiz. inf

< Back I M et = I Cancel

Windows should then display a message indicating that the installation was successful. Click "Finish" to complete the
installation for the serial converter driver for this port of the device. The COM port emulation driver must be installed
after this has completed.

Found Mew Hardware VWizard i

Completing the Found New
%‘ Hardware Wizard

N

_\> I1SE Sernal Canverter

YWindows has finizhed inztalling the software for this device.

To cloze this wizard, chck Finish.

& Bach I Finizh I Eanee]
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By examining the Device Manager (located in "Control Panel\System" then select the "Hardware" tab and click
"Device Manger...") and viewing by connection ("View > Devices by connection"), the device appears as a "USB
Serial Converter" with an additional COM port with the label "USB Serial Port".

I Il
Action  Yiew || - = | | | EX |J |

- |I;|| Inkel(R) 82801EE LPC Interface Controller - 2400 ;l
-3 Inkel(R) 52801E8 PCI Bridge - 244E
i L-EE Intel(R) PROY100 YE Mebwork Conmection

i LB Realtek RTLS139/510x Family Fast Ethernet MIC
----- |I;|| Inkel{R) 82801EB SMBus Controller - 2402

- 5= Inkel(R) 5280166 Ulkra ATA Storage Contrallers

--% Intel{R) §2301EE Ulkra ATA Storage Controllers

-6 Intel(R) 62801ER USE Universal Host Controller - 2402
- Intel{R) S2801EE IUSE Universal Host Controller - 2404
El Intel{R}l G2301EE USE Universal Host Controller - 2407

ISE Serial Converter

i # USE Serial F'u:urt LZOM3)

. 5‘-“-9 I e raEas i
@ InkeliR) G2865G Graphics Contraoller

b Inkel(R) 82865 PEVP Processaor o IO Centroller - 2570

% Realtek AC'7 Audio

: ‘L";l, System board

|= pudio Codecs I

B> Legacy Audia Drivers

-~ Legacy Mideo Capture Devices

Logical Dsk Manager

% Media Ccntrnl Dewces ;I

Contraller - 240E

Please note:

1. For multiple-port converter, each port has to be installed with the driver individually, i.e. you have to repeat this
installation procedure 2 times (2-port converter) or 4 times (for 4-port converter).

2. If you have any difficulties with the drivers we provided in this CD, you may download the updated or appropriate
versions from FTDI Web site: www.ftdichip.com/Drivers/VCP.htm, supported device “FT232BL(M)".
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Uninstalling Instruction

When uninstalling devices from Windows 2000, it should always be done through the Add/Remove Programs utility
as this uses the FTDI driver uninstaller program to remove files and registry entries to leave a clean system. Other
methods may leave fragments of the driver that may interfere with future installations.

Disconnect any devices that are attached to the PC.

Open the Add/Remove Programs utility located in "Control Pane\Add/Remove
Programs ".Select "FTDI USB Serial Converter Drivers" from the list of installed programs.

-0l
=[]

Sort by:| Mame -

fi FTDIUSB Serial Converter Drivers

Click here for support information,

= '. e P WOl
(L o ChangeRemove

Click the "Change/Remove" button. This will run the FTDI uninstaller program. Click "Continue" to run the uninstaller
or "Cancel" to exit.

FTDI Uninstaller x|

If your USH device is connected, please unplug it now ...

Press Continue to uninstall the drivers, or Cancel to guit.

When the uninstaller has finished removing the device from the system, the caption on the "Cancel" button will
change to "Finish". Click "Finish" to complete the process.

21-50



FTDI Uninstaller
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Troubleshooting
1. Windows 2000 cannot find drivers for my device

This error can occur if the VID and PID programmed into the device EEPROM do not match those listed in the INF
files for the driver. The VID and PID programmed into

the device EEPROM may be found by using the USBView utility from the FTDI web site. These can then be checked
against the VID and PID entries in the driver INF files. If they do not match, that driver cannot be installed for that
device without either re-programming the device EEPROM or modifying the list of VID and PID numbers in the INF
files. Please note that only your own company VID and PID or FTDI's VID (0x0403) and FTDI PID issued for use by
your company should be used in the EEPROM and INF/INI files.

2. Windows 2000 forces a reboot after installing a device

This problem can occur if an application is accessing a file while the New Hardware Wizard is trying to copy it. This
usually occurs with the FTD2XX.DLL file. Selecting

not to restart the computer then unplugging and re-plugging the device may allow the device to function properly
without restarting. Restarting the machine will allow the device to work correctly.

3. Driver installation fails and Windows 2000 gives error code 10

Windows error code 10 indicates a hardware error or failed driver installation. This

error may appear if a device has insufficient power to operate correctly (e.g. plugged into a bus powered hub with
other devices), or may indicate a more serious hardware problem. Also, it may be indicative of USB root hub drivers
being incorrectly installed. Please refer to the example schematics on the FTDI web site for standard device
configurations.
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Windows CE Installation Guide

Download the latest available drivers for the required processor model from the FTDI website and unzip them, the
critical files in the driver package are:

ftdi_ser.dll - the VCP driver file
FTDIPORT.inf - user changeable file to allow devices with custom VID and PID combinations to be installed
Copy all of the unzipped files to the \Windows directory on the PDA.

If the PDA requires a host adaptor (e.g. USB host cable, presentation pack or Compact Flash host card), make sure
that it is connected and installed before proceeding.

Connect the FTDI device to a host USB port on the PDA. This will provide a dialog box to direct Windows CE to the
driver files.

Type the full name of the VCP driver file into the dialog box as shown below. If the file name is incorrect, the driver
will not be found and the device will not function.

Unidentified USB D 7 =% 12:04
(9 sunday, June 01, 2003

Enter the name of the device
driver for this device. For
information, see the device
marufacturer's documentation, -

o imilE

1231({2(3[4|5|6|7]8[9]|0]-|=
Tabla[wle[r[t[y[u[i]o]p[[]]
CAPla s [d[ffafh[;[k]!

"
r

|
o

shitt[z [x[c[v]b[n[m][, [. [7]
cufaa] " |\ ] BEHEE
=

The device installation is now complete. The installation may be verified using the test program available form the
Utilities page of the FTDI website.

Please note:

1. For multiple-port converter, each port has to be installed with the driver individually, i.e. you have to repeat this
installation procedure 2 times (2-port converter) or 4 times (for 4-port converter).

2. If you have any difficulties with the drivers we provided in this CD, you may download the updated or appropriate
versions from FTDI Web site: www.ftdichip.com/Drivers/VCP.htm, supported device “FT232BL(M)".
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Troubleshooting

1. "Unidentified USB Device" dialog is not displayed when device is connected for the first time

If the "Unidentified USB Device" dialog is not displayed when the device is connected for the first time, it is likely that
the PDA does not have a USB host capability or that the host is not installed correctly.

Many PDAs require some form of adaptor (USB host cable, presentation pack or Compact Flash USB host card) to
provide the USB host capability that FTDI devices require.

2. "Error installing USB driver ftdi_d2xx.dll" message

The following installation error may be displayed for a number of reasons:

£ | unidentified USB D & x 10:36

(¥ sunday, June 01, 2003
F=] Tap here to set owner information

=] MNoupcoming appointments

] Unidentified USB Device

| Error installing USE driver
Frdi_d2ux

New Tools Accounts [ = E|‘

The driver name has been misspelt - The ".dlIl" file extension may be required for some platforms - The required driver
files are not in the \Windows directory - The driver file is in the wrong binary format
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3. "Error installing USB driver ftdi_ser.dll" message

The following installation error may be displayed for a number of reasons:

£ | Unidentified USB D & x 12:17

(9 sunday, June 01, 2003
F=] Tap here to set owner information

[3 Mo upcoming appaintments

Error installing USE driver
fdi_ser.dl

New Tools Accounts E % E|‘

The driver name has been miss pelt - The ".dIl" file extension may be required for some platforms - The required driver
files are not in the \Windows directory - The driver file is in the wrong binary format

4. "Unidentified USB Device" appears each time the driver name is entered
This error can be caused when the VID and PID listed in the INF file does not match the VID and PID combination
programmed into the device. It can also be caused if the INF file has not been copied to the \\Windows directory.

| Unidentified USB D & o 10:38

£ |unidentified USB D & o 12:04
(® sunday, June 01, 2003 (® sunday, June 01, 2003

= Unidentified USB Device = nidentified USB Device

B Enter the name of the device
& driver for this device. For

lw| information, see the device
| manufacturer's documentation,

B Enter the name of the davice
] driver for this device. For

|w| information, see the device
| manufacturer's documentation,
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One way to check this is to use the Registry editor that comes with Embedded Visual C++ (or a suitable registry editor
on the Windows CE device itself) to check for the registry settings (Tools > Remote Registry Editor). With ActiveSync
running, connect to your device then look at the registry setting KEY_LOCAL_MACHINE\Drivers\USB\LoadClients\

laix

ok il il B L bl BRE 5

) | O O 8 2 ]
% = My Compuber A M |D-abu
= -E POCKET PC 2003 Dirvice AL (Do) {vahmm not set)
=+ HKEY _CLASEES ROCT
%1 | HKEY_CURRENT LISER
- HEEY_LOCAL MACHINE
# ] Comm
E ] ConkaoP e

= ) UsE
-] ChandDireir s
(2] FiD0_DEvecE_soio

[POCKET P2 2000 Devic\HRET_LOCAL_HACHINDrrver s8I Load erks LOZT_24552]

In this case, the entry is 1027_24592, which corresponds to a VID of 0x0403 (1027) and a PID of 0x6010 (24592)
device. If this is not the device to be installed, the message will recur.

To solve the problem, the INF files must be edited to accommodate the required VID and PID. For the D2XX drivers,
edit the bold red entries in the following line in the ftd2xx.inf file:

[FtdiHw]
"ETDI Dual device"=FTDI,USB\&VID_0403&PID_6010

For the VCP drivers, edit the bold red entries in the following line in the FTDIPORT.inf:

[FtdiHw]
%VID_0403&PID_6010.DeviceDesc%=FtdiPort232,FTDIBUS\COMPORT&VID_0403&PID_6010
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5. Device can write but cannot read

If the hardware does not work correctly under Windows 2000 or Windows XP then the problem is most likely a
hardware issue. Windows CE is not very tolerant of noisy hardware, so even "good" designs for Windows 2000 and XP
may experience problems with Windows CE.

Another issue that has arisen with Windows CE is that different host devices support different bulk transfer sizes. One
method to attempt to resolve this is to reduce In Transfer Size to 64. This is the smallest possible transfer size and will
have a severe effect on performance, but should resolve most other issues. Larger values may be tried to improve
performance.

If a USB host CF card is being used, it may help to set the Raton bit in the configuration settings.

6. Bytes missing or data corrupt

This can occur when a host driver fails to send vendor commands properly which can result in the device running at a
different Baud rate to the one intended. The Baud rate can be verified easily by transferring data from PDA/target to
HyperTerminal.

Some host device drivers have been seen to lose packets of data which would also cause this problem.

7. Driver isn't sending or receiving any data
Sending and receiving data can be tested with an application such as VCPTest. However, this will not highlight

problems due to incorrect Baud rates. To check for the wrong Baud rate being set, try to transfer data from the
PDA/target to and from HyperTerminal.
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Windows XP Installation Guide

1. Installing Via The Found New Hardware Wizard

If a device of the same type has been installed on your machine before and the drivers that are about to be installed
are different from those installed already, the original drivers need to be uninstalled. Please refer to the Uninstalling
instruction.

Download the latest available drivers from the FTDI web site and unzip them to a location on your PC.

If you are running Windows XP or Windows XP SP 1, temporarily disconnect your PC from the Internet. This can be
done by either removing the network cable from your PC or by disabling your network card by going to the "Control
Panel\Network and Dial Up Connections", right clicking on the appropriate connection and selecting "Disable" from the
menu. The connection can be re enabled after the installation is complete. This is not necessary under Windows XP
SP 2 if configured to ask before connecting to Windows Update. Windows XP SP 2 can have the settings for Windows
Update changed through "Control Panel\System" then select the "Hardware" tab and click "Windows Update".

Connect the device to a spare USB port on your PC. If there is no available Internet connection or Windows XP SP 2 is
configured to ask before connecting to Windows Update, the screen shown in Figure 2.1 is displayed. Select "No, not
this time" from the options available and then click "Next" to proceed with the installation. If there is an available
Internet connection, Windows XP will silently connect to the Windows Update website and install any suitable driver it
finds for the device in preference to the driver manually selected.

Found New Hardware Wizard

Welcome to the Found New
Hardware Wizard
‘windows will search for current and updated software by

looking on your computer, on the hardware installation CD, or on
the "Windows Update \Web site [with your permission).

Online privacy information

Can Windows connect to Windows Update to search for
zoftware?

O s, this time only

wery time | connect a device

Click Mext to continue.

[ Mest » ][ Cancel

Figure 2.1

Select "Install from a list or specific location (Advanced)" as shown in Figure 2.2 below and then click "Next".
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Select "Search for the best driver in these locations" and enter the file path in the combo box ("C:\CDM 2.02.04" in
Figure 2.3 below) or browse to it by clicking the browse button. Once the file path has been entered in the box, click

next to proceed.

Found New Hardware Wizard

Thiz wizard helps you ingtall software for:

USE Serial Corwerter

f:-) If your hardware came with an installation CD
32 or floppy disk, insert it now.

what do pou want the wizard to do’?

() Install the software automatically [Recommended)
(&)iinstall from a list or specific locabon [&dvancedf

Click Mext to continue.

[ < Back ” et > ][ Cancel

Figure 2.2

Found New Hardware Wizard
Pleasze choose your search and installation options. .

() Search for the best diver in these locations.

Uze the check boxes below to limit or expand the default search, which includes local
paths and removable media. The best driver found wil be installed.

[ 5earch removable media (foppy, CO-ROM...)

Include this location in the search:

| CHCOM 2.02.04 v

(O Don't search. | will choose the driver ta install.

Choose this option to select the device driver from a list. *Windows does not guarantes that
the driver you choose will be the best match for pour hardware.

[ < Back ][ Mest » ][ Cancel

Figure 2.3

If Windows XP is configured to warn when unsigned (non WHQL certified) drivers are about to be installed, the
message dialogue shown in Figure 2.4 will be displayed unless installing a Microsoft WHQL certified driver. Click on
"Continue Anyway" to continue with the installation. If Windows XP is configured to ignore file signature warnings, no

message will appear.

The screen shown in Figure 2.5 will be displayed as Windows XP copies the required driver files.
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Hardware Installation

| E The zoftware pau are installing for this hardware:
-

USE Serial Converter

has not passed Windows Loga testing to verify itz compatibility with

thiz werzion of Windows. [Tell me why this testing iz important]

Continuing your installation of thiz software may impair
or destabilize the correct operation of your system
either immediately or in the future. Microsoft strongly
recommends that pou stop this installation now and
contact the hardware vendor for software that has
passed Windows Logo testing.

’ Comtinue Sryway ] [ STOP Installation {

Figure 2.4

Found New Hardware Wizard
Please wait while the wizard installs the software... .

g UISE Serial Converter

7, =

frd 2.l

To CAWINDDWSaystern32

[FEesmmR AR )
Figure 2.5

Windows should then display a message indicating that the installation was successful (Figure 2.6). Click "Finish" to
complete the installation for the first port of the device.

The Found New Hardware Wizard will launch automatically to install the COM port emulation drivers. As above, select
"No, not this time" From the options and click "Next" to proceed with the installation (Figure 2.7).
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Found New Hardware Wizard

Completing the Found New
Hardware Wizard

The wizard has finished instaling the software for:

g USE Serial Corvverter

Click Firigh to close the wizard.

Figure 2.6

Found New Hardware Wizard

Welcome to the Found New
Hardware Wizard
windows will zearch for current and updated software by

looking on vour computer, on the hardware installation CD, or on
the Windows pdate ‘Web site [with vour permissian).

Online privacy information

Can Windows connect to Windows Update to search for
zoftware?

(O s, this time only

(T3 s, now and every time | connect a device

®

Click Mext to continue,

[ Mext » ][ Cancel

Figure 2.7

Select "Install from a list or specific location (Advanced)" as shown in Figure 2.8 below and then click "Next".

Select "Search for the best driver in these locations" and enter the file path in the combo box ("C:\CDM 2.02.04" in
figure 2.9 below) or browse to it by clicking the browse button. Once the file path has been entered in the box, click
next to proceed.
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Found New Hardware Wizard

Thiz wizard helps you ingtall software for:

USE Serial Port

f':-) If your hardware came with an installation CD
382 or floppy disk, insert it now.

What do pou want the wizard to do”?

O Install the software automatically (Fecommendsd)

Click Mext to continue.

[ < Back “ Mext » ][ Cancel

Figure 2.8

Found New Hardware Wizard
Pleasze choose your search and installation options. .

Uze the check boxes below to limit or expand the default search, which includes local
paths and removable media. The best driver found wil be installed.

[ 5earch removable media (foppy, CO-ROM...)
Include this location in the search:

[CACDM 2.02.04 v

(O Don't search, | will choose the driver ta install,

Choose this option to select the device driver from a list. ‘Windows does not guarantes that
the driver you choose will be the best match for pour hardware.

[ < Back ” Mext > ][ Cancel

Figure 2.9

If Windows XP is configured to warn when unsigned (non WHQL certified) drivers are about to be installed, the
message dialogue shown in Figure 2.10 will be displayed unless installing a Microsoft WHQL certified driver. Click on
"Continue Anyway" to continue with the installation. If Windows XP is configured to ignore file signature warnings, no
message will appear.

The screen shown in Figure 2.11 will be displayed as Windows XP copies the required driver files.
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Hardware Installation

1 E The zoftware vou are installing for this hardware:
*
USE Serial Part

has not paszed Windows Logo testing to verify itz compatibility with

thiz werzion of Windows. [Tell me whey this testing is important]

Continuing your installation of this software may impair
or destabilize the correct operation of your system
either immediately or in the future. Microsoft strongly
recommends that you stop this installation now and
contact the hardware vendor for software that has
passed Windows Logo testing.

[ Continue Aryway ] [ STOP Installation |

Figure 2.10

Found New Hardware Wizard
Please wait while the wizard installs the software... .

(3 UUSE Serial Port

L Ly
frzeruiz.dl
To CAWINDOWShaysten32
[ 1l
Figure 2.11

Windows should then display a message indicating that the installation was successful (Figure 2.12). Click "Finish" to
complete the installation for the first port of the device.

Open the Device Manager (located in "Control Panel\System" then select the "Hardware" tab and click "Device
Manger") and select "View > Devices by Connection”, the device appears as a "USB Serial Converter" with an
additional COM port with the label "USB Serial Port" (Figure 2.13).
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Found New Hardware Wizard

Completing the Found New
Hardware Wizard

The wizard has finished instaling the software for:

/g IUSE Serial Port

Click Firigh to close the wizard.

Figure 2.12

Device Manager

File  Action  Wiew Help

&g 2
'd ACPI Fixed Feature Button ~
% Genuing IntellR) CPU 2160 @ 1,80GHz
##® Genuing IntellR) CPU 2160 @ 1,80GHz

= i PCIbus

&3 vé InkelfR) 94662 Express Chipset Family
[+ ' Inkel(R) 52801 PCI Bridge - 244E
IntelfR) 62801 G {ICHF Family) SMBus Controller - 2704
[+ Inkel{R) 828010G (ICHT Family) USE Universal Host Controller - 27C&
[= Inkel{R) §28010G (ICHT Family) USE Universal Host Contraller - 27C9
P L =
USE Serial Corwerter
SE Serial Port (COM3)
+ e TT02E Universal Host Controller - 27CA
+ Inkel{R) 82801G (ICH7 Family) USE Universal Host Contraller - 27C6
+ Intel{R) 82801G {ICH7 Family) USEZ Enhanced Host Controller - 27CC
= _& Intel{R) 82801 GE{GR (ICHT Family) LPC Interface Contraller - 2768
[+ InteliR) 82801GB{GR/GH (ICH? Family) Serial ATA Storage Controller - 27C0
_} IntellR) 946GZfPLGL PCI Express Root Port - 2971
j IntellR) 946GZIPLIGL Processor ko I Controller - 2970
= _} Micrasoft L&A Bus Driver For High Definition Audio
¢ Motherboard resources v

Figure 2.13

Device Manager

File  Action  View  Help
g &

2 } PCI bus A
+ é Intel{R) 946GZ Express Chipset Family
+- 1J InkeliR) 52801 PCI Bridge - 244E
Inkel{R) 82801G {ICH7 Family) SMBus Contraller - 2704
[+ Intel{R) 82801G {ICH7 Family) USE Universal Host Contraller - 27C5
[# IntelfR) 82801G {ICH7 Family) USE Universal Host Contraller - 27C9
= IntelfR) 82801G (ICH7 Family) USE Universal Host Contraller - 27CA

= |USE Composite Device
= Q USB Serial Converter &
5 UsB Serial Fort (COM3)
= Q USB Serial Converter B
3 USB Serial Fort (COM4)
InkeliRTEaires et B Dniversal Host Controller - 2706
IntelfR) 62801 G (ICHF Family) USEZ Enhanced Host Controller - 27CC
_é IntelfR) 62801 GEJER (ICHT Family) LPC Interface Controller - 2768
[+ Inkel(R) 52801 GE{GR /GH (ICH7 Family) Serial ATA Storage Controller - 27C0
j Intel{R) 946GZ(PL/GL PCI Express Root Port - 2971
j Inkel{R) 946GEIPL/GL Processar to IjO Controller - 2970
[+ j Microsoft LUAA Bus Driver For High Definition Audio
} Motherboard resources v

[+
[+
[+

Figure 2.14
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2. Installing Using DPInst

In the case of a Microsoft WHQL certified driver package, it is possible to preinstall the driver package using the
Microsoft Driver Install Frameworks (DIFxX) tools. The simplest tool provided is the Driver Package Installer (DPInst).
When placed in the same directory as the INF files for the driver package, simply run DPInst.exe and the certified
driver package will be installed on the machine.

The current driver package supports 32bit and 64bit systems through common INF files. DPInst has separate
executables for 32bit and 64bit installation. This means that if a single solution is desired for 32bit and 64bit systems,
the developer must be able to detect which version of DPInst is required for the system the driver is being installed on.

For more information on DPInst, see the FTDI Windows Driver Installation application note.

3. Installing From Windows Update

If a certified driver is available for the target operating system, it is possible to install the driver from the Windows
Update web site.

Directions to install the driver from Windows Update are very similar to those outlined in 2.1 Installing Via The New
Hardware Wizard, except that the “Yes, this time only” or “Yes, now and every time | connect a device” option should
be selected on the first screen of the wizard when asked if Windows Update should be checked for a driver. If the
wizard finds a matching driver on Windows Update, the driver will be automatically downloaded and installed for the
device.

Please note:

1. For multiple-port converter, each port has to be installed with the driver individually, i.e. you have to repeat this
installation procedure 2 times (2-port converter) or 4 times (for 4-port converter).

2. If you have any difficulties with the drivers we provided in this CD, you may download the updated or appropriate
versions from FTDI Web site: www.ftdichip.com/Drivers/VCP.htm, supported device “FT232BL(M)”.
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Uninstalling Instruction

Consequently, a new method for uninstalling has to be used. Devices can be removed using the Device Manager by
simply right clicking on the device and selecting "Uninstall". This will delete the associated registry entries for that
device only.

Under Windows XP, driver files and OEM INF and PNF files must be removed manually or by using a custom
application. OEM INF and PNF files are located in the Windows\Inf directory and can be identified by searching for a
VID and PID string matching the device installed e.g. VID_0403&PID_6001. Once the matching OEM INF files are
found (e.g. oem10.inf for FTDIBUS.INF and oem11l.inf for FTDIPORT.INF), the corresponding PNF files must also be
removed (e.g. oemlO.pnf and oemll.pnf). Driver files are located in the Windows\System32 and
Windows\System32\Drivers directories.

Some points to note about this uninstallation method:

If the VCP driver has been installed, the COM port driver should be removed before the bus driver. If the bus is
removed first, the COM port will no longer appear in the Device Manager.

If the driver files are deleted while other installed devices still require them those devices will not work correctly. This
can be fixed by right clicking the device and selecting "Reinstall Driver" which will replace the missing files.

If a device to be uninstalled is not connected to the PC, the device can still be removed by setting the device manager

to show phantom devices. This can also allow a virtual COM port to be uninstalled if the bus layer has been removed
first. Instructions on how to display phantom devices are given in the Advanced Driver Options application note.
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Troubleshooting

1. Windows XP cannot find Drivers for My Device

This error can occur if the VID and PID programmed into the device EEPROM do not match those listed in the INF files
for the driver. The VID and PID programmed into the device EEPROM may be found by using the USB View utility
from the FTDI web site. These can then be checked against the VID and PID entries in the driver INF files. If they do
not match, that driver cannot be installed for that device without either reprogramming the device EEPROM or
modifying the list of VID and PID numbers in the INF files.

Please note that only your own company VID and PID or FTDI's VID (0x0403) and FTDI PID issued for use by your
company should be used in the EEPROM and INF/INI files.

End customers should obtain modified drivers from the OEM of the device, and not necessarily edit the files
themselves.

2. Windows XP Forces a Reboot after Installing a Device

This problem can occur if an application is accessing a file while the New Hardware Wizard is trying to copy it. This
usually occurs with the FTD2XX.DLL file. Selecting not to restart the computer then unplugging and re-plug the device
may allow the device to function properly without restarting. Restarting the machine will allow the device to work
correctly.

3. Driver Installation Fails and Windows XP Gives Error Code 10

Windows error code 10 indicates a hardware error or failed driver installation. This error may appear if a device has
insufficient power to operate correctly (e.g. plugged into a bus powered hub with other devices), or may indicate a
more serious hardware problem. Also, it may be indicative of USB root hub drivers being incorrectly installed.

Please refer to the example schematics on the FTDI web site for standard device configurations. If the error persists,
please contact the FTDI support department.

4. Windows XP Displays An Error And Then Terminates Installation

If the following screen is displayed with this message, Windows XP has been configured to block the installation of any
drivers that are not WHQL certified.
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Hardware Installation

@ The software you are installing for this hardware:
USB Serial Converter

has not passed Windows Logo testing to verify its compatibifity
wath this version of Windows. [Tell me wh this testing is important]

This hardware will not be nstalled. Contact pour system
adminiztrator.

Figure 4.1

Two options are available to successfully install the device. Either a certified version of the driver can be installed (if
available) or the driver signing options can be changed to either warn or ignore to allow the installation to complete.

To change the current driver signing setting, go to "Control Panel\System", click on the "Hardware" tab and then click
"Driver Signing". The desired signing option may then be selected.
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Windows Vista (Win 7, 8, 8.1, 10) Installation Guide

Connect the device to a spare USB port on your PC.

If there is an available Internet connection, Windows VISTA (Win 7, 8, 8.1, 10) will silently connect to the Windows
Update website and install any suitable driver it finds for the device in preference to the driver manually selected. If no
suitable driver is automatically found then the following procedure should be followed.

I Fonind Mew Haschume:

5=

Windows needs to install driver software for your TTL232R
Tester

@ Locate and install driver software (recommended)

Windows will guide you through the process of installing driver software
for your device,

# Ask me again later
Windows will ask again the next time you plug in your device or log on,

® Don't show this message again for this device
Your device will not function until you install driver software.

When locate and install driver software (recommended)" is selected the following screen will appear. Note: the text
“TTL Tester” is replaced with the description of the customer hardware.

%
(‘__j (| Found New Hardware - TTL232R Tester
Insert the disc that came with your TTL232R Tester

If you have the disc that came with your device, insert it now. Windows will automatically
search the disc for driver software.

* Idon't have the disc. Show me other options.
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Select “| don’t have the disk. Show me other options” The next screen will appear.

iz

@ L Found New Hardware - TTL232R Tester

Windows couldn’t find driver software for your device

= Check for a solution
Windows will check to see if there are steps you can take to get your device
working.

# Browse my computer for driver software (advanced)
Locate and install driver software manually.

Select “Browse my computer for driver software (advanced)”. The next screen will appear.

K3 L FoundNewHardware - TTL232R Tester
Browse for driver software on your computer

Search for driver software in this location:
Ci\Users] Desktop\CDM 2.00.00 (Certified)

[¥] Include subfolders

Browse to the folder where the CDM driver has been stored (when uncompressed) and press “Next”
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The example shown above uses a folder on the desktop.
The next screen will appear

=
‘. J U FoundMNew Hardware - TTL232R Tester
Installing driver software...
This screen will automatically complete and then change to the one below:
P |
:
Ve [ Found New Hardware - USB Serial Converter
The software for this device has been successfully installed
Windows has finished installing the driver software for this device:
USB Serial Converter

The bus layer of the driver is now installed.

After the driver is installed it is important to determine which COM port has been assigned to the device for configuring
the application that will use the device.

Open the Device Manager (located in "Control Panel\System" then select the "Hardware" tab and click "Device
Manager") and select "View > Devices by Connection”, the device appears as a" USB Serial Converter" with an
additional COM port with the label "USB Serial Port".
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4 Device Manager =
File Action View Help
Lk Aol 7 Hosll

4% Computer

#-(=y Disk drives

+- By, Display adapters

&g DVD/CD-ROM drives

4 = Floppy disk drives

+ <= Floppy drive controllers

-8 Human Interface Devices

[t g IDE ATA/ATAPI controllers

#- § IEEE 1394 Bus host controllers

i\ = Keyboards

o] !3 Mice and other pointing devices

3] & Monitors

- Network adapters

B Portable Devices

=% Ports (COM & LPT)

i 2 Communications Port (COM1)
2 Printer Port (LPT1)

| L.037 USE Serial Port (COM3)

& B Processors

-4/ Sound, video and game controllers

! & High Definition Audio Device

+‘ <5 Storage controllers

%18l System devices

- @ Universal Serial Bus controllers

This screen shows the device connected to COM3.

Please note:

1. For multiple-port converter, each port has to be installed with the driver individually, i.e. you have to repeat this
installation procedure 2 times (2-port converter) or 4 times (for 4-port converter).

2. If you have any difficulties with the drivers we provided in this CD, you may download the updated or appropriate
versions from FTDI Web site: www.ftdichip.com/Drivers/VCP.htm, supported device “FT232BL(M)".
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Uninstalling Instruction

With the release of Microsoft Windows Vista (Win 7, 8, 8.1, 10), the FTDI uninstaller has been rendered unusable due
to Windows Resource Protection preventing the executable from deleting driver files and associated registry values.
Vista will only allow the system itself to modify files and registry values in these locations.

Consequently, a new method for uninstalling is required. Devices can be removed using the Device Manager by simply
right clicking on the mouse and selecting "Uninstall". This will delete the associated registry entries for that device only.
Vista provides an automatic method to delete driver files via a check box to "Delete the driver software for this device"
on the uninstall dialog box.

Confirm Device Uninstall

LISE Senal Converer
B

Waming: You are about to uninstall this device from your system.

| ok || Concd |

Windows 2000, XP and Server 2003 do not have this check box, so driver files and OEM INF and PNF files must be
removed manually or by using a custom application.

Some points to note about the new uninstallation method:

If the VCP driver has been installed, the COM port driver should be uninstalled before the bus driver. If the bus is
removed first, the COM port will no longer appear in the Device Manager.

If the files are deleted while other installed devices still require them those devices will not work correctly. This can be
fixed by right clicking the device and selecting "Reinstall Driver" which will replace the missing files.

If a device to be uninstalled is not connected to the PC, the device can still be removed by setting the device manager
to show phantom devices. This also allows a virtual COM port to be uninstalled if the bus layer has been removed first.
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Troubleshooting

1. Windows Vista (Win 7, 8, 8.1, 10) can not find drivers for my device

This error can occur if the VID and PID programmed into the device EEPROM do not match those listed in the INF files
for the driver. The VID and PID programmed into the device EEPROM may be found by using the USB View utility
from the FTDI web site. These can then be checked against the VID and PID entries in the driver INF files. If they do
not match, that driver cannot be installed for that device without either reprogramming the device EEPROM or
modifying the list of VID and PID numbers in the INF files. Please note that only your own company VID and PID or
FTDI's VID (0x0403) and FTDI PID issued for use by the customer should be used in the EEPROM and INF files.

End customers should obtain modified drivers from the OEM of the device, and not necessarily edit the files
themselves.

2. Devices not shown in Device Manager for uninstalling

Devices that have been installed on a system but are not currently available are referred to as "phantom devices".
These devices are not usually displayed in the device manager, but can be made to be displayed as though they are
attached. This allows device properties to be changed or devices to be uninstalled via Device Manger even though the
device is not physically connected to the PC.

To display phantom devices in Device Manager, a new system variable is required. Open "Control Panel > System"
then select the "Advanced" tab and click "Environment Variables". In the System Variables section (NOT THE USER
VARIABLES SECTION), click "New..." to display the following window:

Edit System Variahle 3]
Variable name: DevMar_Show_MonPresent_Devices
Variable value: 1]
[ OK | | Cancel

Create a new System Variable called "DevMgr_Show_NonPresent_Devices" and set the value to 1, then click OK.
Open the Device Manager ("Control Panel > System" then select the "Hardware" tab and click "Device Manager...", or

"Control Panel > Device Manger" in Vista) and select "View > Show Hidden Devices". Device Manager will then show
all hidden and phantom devices available on that PC as shaded.
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3. Windows Vista (Win 7, 8, 8.1, 10) shows a warning that the driver is not certified

If the driver is not certified then a pop up window such as shown below will be displayed.

fg} Windows Security

@ Windows can't verify the publisher of this driver software

<+ Don't install this driver software
You should check your manufacturer's website For updated driver software For wour
device,

<% Install this driver software anyway
Cnly inskall driver software obtained From wour manufacturer's website or disc,
Unsigned software from other sources may harm your computer or skeal information.

Ll See details

If you are certain of the source of the driver the warning can be ignored and you can continue installation by selecting
“Install this driver software anyway”.

4. Driver will not install on VISTA x64

VISTA x64 OS will only allow certified drivers to be installed. The certified driver supplied by FTDI will work with VID
0403 and PID 6001 for FT232 and FT245 devices.

If you have a product where the manufacture has customized the driver but has not recertified it, then the driver will not
load. You should contact your vendor to determine if they will support VISTA x64.
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MAC OS X Installation Guide

Download the driver from the VCP Drivers section of the FTDI web site and save it to the hard disk. The driver is now
available in disk image (.dmg) format. Run the installer by double clicking on the FTDIUSBSerialDriver.dmg icon.

"®ON Install FTDIUSBSerialDriver Kernel Extension

E-‘ = Welcome to the Mac 0S X Installation Program. You will be
© Introduction guided through the steps necessary to install this software.

® Read Me

Welcome to the FTDIUSBSerialDriver Kernel Extension Installer

L] Sele.ﬁ‘t Destination
® Installatien Type

® Installing

® Finish Up

_

_Ei_o_ls_e_ck_ [ Continue |

Click Continue to proceed with the installation and follow the instructions on screen.

When the installation is complete, reboot the computer.

rﬁ en Install FTDIUSBSerialDriver Kernel Extension

O Introduction
© Read Me

Install Software

2 Se Ie-ét Destination

O Installation Type
© Installing The software was successfully installed

® Finish Up -

Click Restart to finish installing the software.
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When the computer has rebooted, plug in the device. If the device is installed properly, you will see entries in the /dev
directory:

/dev/cu.usbserial-xxxxxxxx
/devl/tty.usbserial-xxxxxxxx

Where xxxxxxxx is either the device's serial number or, for unserialized devices, a location string that depends on
which USB port your device is connected to. The Terminal application can be launched by selecting Go > Applications
> Utilities > Terminal. Type the following lines in the Terminal window to produce the file list:

cd /dev
Is-|

If you run the application System Preferences and select Network (Go > Applications > System Preferences >
Network), you should see the text "New Port Detected".

New Port Detected

i w A new network port has been detected:
usbzerial-1B22

Please verify that it is configured correctly, then

press Apply Mow to activate i,

Click OK and select Network Port Configurations from the show list. The new port can be enabled from this screen by
checking the on box and clicking Apply Now.

= _—)
enn Network (=)
e W QS B
Show All Displays Sound Network Startup Disk
Location: Automatic o

Show: Network Port Configurations | 3‘1

Check a configuration to make it active.
Drag configurations into the order you want to try them when
connecting to a network.

On | Port Configurations

B ushserial-1822

E Internal Modem { BB
#  Built-in Ethernet C Bt D)
( Delete.. )
& Duplicate b}
@
- iy — :
[ Click the lock to prevent further changes. [ Assistme... ) [ Apply Now |
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At this point, it is possible to exit Network and use the device as a COM port. If you wish to set the device up a modem
for an Internet connection, select the new port from the show list to display the window below.

'_6 e o Metwork =

w -y G

Show All Displays Sound  MNetwork Startup Disk

Location: Automatic [

- e

Show: ushserial-1822 |

-

[ pPP | TCP/IP | Proxies | Modem |

Service Provider: (Optional)

Account Nama:

Password:

Telephone Number:

Alternate Number: (Optional)

| Save password

Checking tis box allows all users of this computer to
access this Internet account without entering a password.

li PPP Options... b} ( Dial Mow... \J
. S
' Click the lock to prevent further changes. [ Assistme... ) Apply Now

Entries for this screen are specific to the Internet account for each user. If you do not know the required details, contact
your Internet service provide

Please note:

1. For multiple-port converter, each port has to be installed with the driver individually, i.e. you have to repeat this
installation procedure 2 times (2-port converter) or 4 times (for 4-port converter).

2. If you have any difficulties with the drivers we provided in this CD, you may download the updated or appropriate
versions from FTDI Web site: www.ftdichip.com/Drivers/VCP.htm, supported device “FT232BL(M)".
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Uninstalling instruction

To remove the drivers from Mac OS X, the user must be logged on as root. Root is a reserved username that has the
privileges required to access all files.

Start a Terminal session (Go > Applications > Utilities > Terminal) and enter the following commands at the command
prompt:

cd /System/Library/Extensions

rm -r FTDIUSBSerialDriver.kext

cd /Library/Receipts

rm -r FTDIUSBSerialDriver.kext

The driver will then be removed from the system.

To remove the port from the system, run the application System Preferences and select Network. Selecting Network
Port Configurations from the Show menu will display the port as greyed out. Select the uninstalled port and click Delete.
Confirm the deletion to remove the port.

r ~ =
ean Network (=)
6 [ & &
Show All Displays Sound  MNetwork Startup Disk
Location: | Automatic i

Show: MNetwork Port Configurations | 2-1

Check a configuration to make it active.
Drag configurations into the order you want to try them when
connecting to a network.

On  Port Configurations

usbserial-1B22

internal Modem [ New.. )
Built-in Ethernet I\_}T

Duplicate

A&

@

i P
ﬂjj Click the lock to prevent further changes. [ Assistme... ) Apply Now
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Troubleshooting
1. How do | know what my device ID is?

Launch the System Profiler utility or Apple System Profiler for earlier versions of OS X. This can be accessed by going
to the Finder and selecting Applications from the Go menu then open the Utilities folder.

Select USB under Hardware in the pane to the left and then select the appropriate device from the USB Device Tree.
In the screen shot below (from OS 10.3), the device has a device ID given by:

Vendor Name: FTDI

Product ID: 24577 ($6001)

A Vendor Name of FTDI is equivalent to a Vendor ID of 1027 ($0403).

rB (sl s) System Profile 7
Andy's eMac 10/01/2005 08:37
| Contents USE Device Tree
¥ Hardware USE Bus
Memory ¥ USE Bus
PCI{AGP Cards W¥Hub in Apple Extended USE Keyboard
ATA
SCsI Apple Optical USE Mouse
UsSB Apple Exterded USE Keyboard
FireWire USE Bus
AirPort Card USB High-Speed Bus
Modems
¥ Software
Applicatiors “
Eetertsiony USE <-> Serial: -
Metwork
Logs ~ Wendor Name:  FTDI
Speed: Up to 12 Mb/sec
Product ID: 24577 (36001}

Bus Power (mAj): 100

i

If the device does not work after installing the driver, it is likely to be because the PID is not supported by the driver. If
this is the case, contact FTDI Support with the PID that needs to be added to the driver. If the VID is not 0x0403, it is
likely that the device is not an FTDI device and we cannot support it.

2. The device does not appear in the /dev directory or the text "New Port
Detected" is not displayed in System Preferences-Network

FTDI USBSeria Driver does not support your device ID (VID and PID). Disable the EEPROM so that the device reverts
to its default device ID, then replug. To get support for your device ID built into FTDI USBSerial Driver, contact FTDI

guoting your device ID and a description of your device.

3. The device cannot be accessed even though the device ID is Supported
in FTDI USBSerial Driver

An ownership or permissions problem is preventing the system from making the device accessible. Check that the
driver is owned by root and wheel. The most common symptom is the group for FTDI USBSerial Driver is not wheel.
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To change the group, login as root and perform the following script in a Terminal window (Go > Applications > Utilities
> Terminal):

cd /system/library/extensions

chgrp -R wheel FTDIUSBSerialDriver.kext

Reboot for the change to take effect.

4. How do | open a Terminal window?

A Terminal window can be started by selecting Go > Applications > Utilities > Terminal .The terminal window
is equivalent to a DOS prompt in Windows.
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Regulatory Compliance

Disclaimer

Information in this document is subject to change without notice. The manufacturer does not make any representations or
warranties (implied or otherwise) regarding the accuracy and completeness of this document and shall in no event be liable for any
loss of profit or any other commercial damage, including but not limited to special, incidental, consequential, or other damages.

No part of this document may be reproduced or transmitted in any form by any means, electronic or mechanical, including
photocopying, recording or information recording and retrieval systems without the express written permission of the manufacturer.
All brand names and product names used in this document are trademarks, or registered trademarks of their respective holders.

CE Certification
This equipment complies with the requirements relating to electromagnetic compatibility.
It has been manufactured under the scope of RoHS compliance.

FCC Compliance Statement

This equipment generates and uses radio frequency and may cause interference to radio and television reception if not installed
and used properly. This equipment has been tested and found to comply with the limits of a Class B digital device, pursuant to part
15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential
installation.

You are cautioned that changes or modification not expressly approved by the party responsible for compliance could void your
authority to operate the equipment.

This device complies with part 15 of the FCC Rules. Operation is subject to the following two conditions:

(1) This device may not cause harmful interference, and

(2) This device must accept any interference received, including interference that may cause undesired operation

ﬁ WEEE (Waste of Electrical and Electronic Equipment),
Recycling of Electronic Products

In 2006 the European Union introduced regulations (WEEE) for the collection and recycling of all waste electrical and electronic
equipment. It is no longer allowable to simply throw away electrical and electronic equipment. Instead, these products must enter
the recycling process.

Each individual EU member state has implemented the WEEE regulations into national law in slightly different ways. Please follow
your national law when you want to dispose or any electrical or electronic products. More details can be obtained from your
national WEEE recycling agency.
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